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Reviewing Adobe Photoshop CS2 is a lot like reviewing Italian art. Simply put, there’s 
more to it than you’ll ever get to in one lifetime. But that doesn’t stop me, and it 
shouldn’t stop you, from learning and enjoying one of the most magical and powerful 
software programs available for today’s digital photographer.  
 
Should you invest in CS2 if you already have a picture editing program? Or, should you 
upgrade to CS2 if you already use Photoshop Elements, or an earlier version of 
Photoshop like 7.0 or CS (8.0)? I’ll try to answer these questions as we go, but the list of 
new and improved features in CS2 is so long that this review can’t adequately cover 
them all. I’ll focus on the most popular and useful upgrades of this amazing program, 
including any short comings (yes, Martha, Photoshop does have its faults!). 
 
Photoshop CS2 is version 9, if you’re counting, and it’s the most comprehensive 
upgrade to Photoshop in a long time. CS2 comes with ImageReady, often used to 
prepare graphics for web publishing, but I won’t review that aspect of the program. 
 

 
 
 
First, who needs Photoshop CS2? Photoshop is designed for a wide variety of 
professionals, including Photographers, Graphic Designers, Illustrators, and Web 
Designers, to name a few. While there are many other photo editing programs out there, 
Photoshop is widely recognized as the industry leader. It has become a verb in our daily 
lexicon. We now say, “Photoshop it,” when we mean to say, “Fix the pix.” No other 
photo-visual-graphic program is as comprehensive. Period. Photoshop has been around 
for over 16 years, and will be with us 16 years from now, and probably 60 years from 
now.  So the investment in time and money that Photoshop requires will pay off over the 
long run.  
 



Second, what does Photoshop do for photographers? If you want to improve your 
original, “as-shot” photographic images, restore old photographs, select and use 
portions of your images or multiple images in creative ways, and browse and manage 
all your photo and graphic files efficiently, then Photoshop CS2 offers an extremely 
complete software package. What’s the down side? It’s expensive and complex to learn. 
So let’s get started and take a look at what the newest version of Photoshop has to offer 
today’s digital photographer. 
 
I’ve divided the many new or revised features of Photoshop CS2 into four broad 
categories, 1) File browser & management, 2) Image improvement and restoration, 3) 
Creative selection and layering of photos, and 4) Additional features.  Of course, the 
tools and features of CS2 overlap these four broad categories, but they’ll help us to 
organize our approach to reviewing the newest version of Photoshop.  
 
Part 1: File Browser & Management. Bridge is the newly named file manager and 
browser in CS2, and it is a highly upgraded, stand-alone version of the simple file 
browser in CS. The difference is night and day, especially for quickly changing the size 
of the picture previews, and managing raw photos.  One of the best features in CS2 
Bridge is the ability to choose the size of the preview photo as well as control the 
arrangement and number of thumbnails previewed.  If you are using Windows Explorer, 
like I was, you’ll love the larger image previews in Bridge, which offers 3 preset window 
arrangements for the previews: Filmstrip, Thumbnails, and Details views. All the 
arrangements are customizable and can be saved. Because I shoot in Raw with JPEG I 
arrange two rows, one of each format, down the side so I can compare the two images 
in addition to looking at a large preview.  It also helps to see the Jpeg image and 
compare it to the Raw image for exposure and color. 
      

            
 Bridge with two larger preview columns on right         Bridge with 7 smaller preview columns 
 
Working with raw camera images (not JPEG files) was a bother before Bridge. Now it’s 
a joy to quickly exert a wide range of creative control over many aspects of the image 
before opening it in Photoshop. You’d be amazed at what Bridge can do with raw 
images, and you may want to start shooting in the camera raw format after you try it. 
Photoshop CS2 offers RAW support for almost all digital cameras. The beginner can 
choose from 9 White Balance presets, including Auto, Cloudy and Fluorescent settings; 



there is one just right for each picture. You can easily adjust the white balance, ISO, 
and color balance with great results.  This is one of the great advantages in shooting in 
camera raw format, changing the original camera settings long after the shot was taken! 
The Shadows and Highlights previews (see picture) with the white balance eye-dropper 
provide another quick and easy way to adjust the white balance of the raw image 
without pushing the white and black areas of the image too far.  
 

 
White balance & exposure adjustments in Bridge. Red areas of the image  
indicate blown highlights; blue indicates pure black areas of the picture. 

 
Advanced users will enjoy the many corrective features in Bridge for over or 
underexposed pictures, vignetting (darker corners), chromatic aberration, color noise 
reduction, sharpness, etc. The curves feature displays a full color histogram, and allows 
for changing the exposure, like in Photoshop’s curves adjustment layer. Unfortunately, 
the adjustment is not previewed until after I let go of the slider. An unwanted change 
can then be undone, but it would be better if it previewed the change with the mouse 
button still depressed. 
 



 
Bridge curves adjustment shown in graph on right, with histogram above. 

 
I have two gripes about Bridge. First is Bridge’s irritating habit of jumping to the first 
picture in a folder when I reopen a folder, rather than returning to the last viewed image. 
Second is the inability to choose the browse source before opening up Bridge.  If the 
last folder I browsed before shutting down is large, I will have to wait for the entire 
contents to load before I can change the browser path.  If the last folder was a memory 
card on a peripheral, the browser goes to Desktop and that takes a long time to load as 
well.  I would like to see an option to pre-select the browser/bridge path before opening 
it up. Two work-arounds for this inconvenience are increasing the size of the Camera 
Raw Cache in the Preferences menu, which helps speed up loading time, as does 
buying a faster computer! 
 
The Bridge file browser will perform many more tasks that I don’t use much, such as 
batch processing multiple camera raw images at once, resize, rotate, rename, rate or 
label pictures (like in iPhoto), quickly review images in slideshow mode, search 
metadata information, purchase stock photos online, make contact sheets of photos, 
merge photos, etc.  
 
But there is one more really cool feature I liked, the Straighten Tool. Bridge will let you 
easily correct a “crooked” photo by drawing a straight line anywhere on the picture, and 
realigning and cropping the picture to that horizontal or vertical line. Neat and useful.  
Oh, did I mention that Bridge works with all graphical images like Illustrator files, PDF’s, 



QuickTime movies, etc., and works as an independent browser/file manager without 
opening Photoshop? 
 
Part 2:  Image Improvement and Restoration. This is the meat and potatoes of 
Photoshop. Everyone wants to improve their stock images, or restore old photos to new 
by fixing faded, cracked, or scotch-taped pictures. Last year, I restored a 100 year-old-
baby picture for a 100th birthday celebration, and Photoshop helped transform the 
cracked, faded and, yes, scotch-taped picture into a good-as-new prized heirloom 
photograph! Photoshop is a magic wand! CS2 has now improved several tools that I 
can no longer do without. 
 
Shadow/Highlight is a fantastic adjustment originally from Photoshop CS. A very useful 
feature used to lighten the darker areas of a picture while not changing the properly 
exposed midtones and highlights. Or, you can darken the overexposed highlights while 
leaving the mids and lows untouched.  A huge timesaver and probably the most often 
used feature in Photoshop! When you didn’t use a flash, and the faces are a little too 
dark on a sunny day, or the shadows obscure the details, the Shadow/Highlight 
adjustment is worth its weight in gold! A few tries with the Shadow parameter usually 
gives the “filler flash” effect I want. 
 
The Red Eye Brush, from Elements 3, is a quick and easy one-click to disappear red-
eye in flash photos. It works well on images that have not been cropped or enlarged too 
much.  But I have found that the Red Eye can look artificial if it covers up key lights in 
the eyes, and it has trouble with my dog’s green-glowing-eyes. Fortunately, the Red-eye 
brush has two easy adjustments to change pupil size and the amount the eyes are 
darkened, from 1 to 100%, which help with difficult corrections.  
 
The Spot Healing Brush tool is a quick version of the Healing Brush tool. It lets you skip 
the step of sampling an area of the picture before you heal a blemish, disappear 
wrinkles, hide scotch tape marks, or erase dust spots. It automatically selects the 
surrounding pixels as a sample. Together with the clone tool, these three tools will 
repair most any damaged photograph.  
 
Smart Sharpen is a great new feature that may prove the demise of Unsharp Mask. It 
can be found under Filters>Sharpen>Smart Sharpen. With this tool, you can chose from 
Gaussian blur, Lens blur or Motion blur correction algorithms to sharpen your photos. 
Each has different effects and is somewhat subjective in its usage. I tried an old Arcade 
black and white photo from the twenties that was quite soft. I was able to sharpen the 
photo quite respectably. I found the Lens blur selection worked best for that photo. 
However, when I showed it to the wife, she said she preferred the soft look better. Que 
sera sera. The Lens blur appears to be the algorithm of choice. I liked it the best for 
what I tried. Smart Sharpen is aptly named, as it takes sharpening a step further by 
reducing color halos brought about by standard sharpening, and allowing control over 
sharpening highlights and midtones separately, if desired. It features a nice, large 
preview window, and an easier to use interface. 
 



With my vacation pictures of Italy, I applied Smart Sharpen to every picture before 
printing, and the results were excellent. The crisp, sharp look of the pictures helped the 
photo to “pop.” Look at the sharpness of this owl at 102% magnification after Smart 
Sharpen was applied.  
 

 
Smart Sharpen brings out the details to give punch to the pix 

 
A new filter, the Lens Correction filter, fixes inherent lens flaws such as perspective 
distortion (in the example below, see the tops of the vertical columns that lean in to the 
center when the camera is pointed up), barrel & pincushion distortion, vignetting (dark 
spots in the corners), and chromatic aberration (red or cyan color fringes).  
 
I used this filter today on an interior picture of a Duomo (cathedral) in Sienna, Italy, 
where the tall, black-and-white marble columns appeared to lean into the center of the 
picture. (See the examples below.) It was easy to do; an adjustable grid shows you the 
straight vertical and horizontal lines. I just dragged the vertical slider to correct my tilted 
columns. As you can see, correcting perspective distortion in this picture is a 
compromise, since different columns appear tilted to differing degrees, and need 
differing degrees of correction. This makes correcting this picture an imperfect 
compromise. The corrected picture then has to be cropped, because after straightening 
the column tops, a transparent area is revealed at the bottom of the picture and has to 
be trimmed. 



 

   
Original picture with column tops leaning inwards. After Lens Correction filter; compare the outer columns. 
 
As a convenience, the same Straighten Tool that corrects a picture that’s tilted off the 
horizontal or vertical axis (described above in Bridge) is included in the Lens Correction 
Filter. 
 
The Reduce Noise filter, for night shots or high ISO pics, preserves details while it 
suppresses color noise. The basic filter is easy to use. Advanced users can apply it to 
individual color channels. That’s useful, since noise is sometimes worse on one channel 
than the others. It does a great job of reducing any JPEG artifacts in low-light shots (the 
boxy patterns caused by strong JPEG compression). The danger of noise reduction is 
that as you eliminate noise, you often eliminate sharpness as well. CS2©s Reduce Noise 
filter has an adjustment for preserving detail, and strikes a good balance between 
reducing noise while maintaining image detail.  
 
Photoshop CS2 sports three new Blur Filters including shape, surface and box blurs. I 
have used surface blur for softening faces without affecting the rest of the photo. 
 
Part 3: Creative Selection and Layering of Photos. We’ve all seen the amazing 
“Photoshopped” advertising photos that layer multiple images and create a uniquely 
beautiful or exotic scene.  In Photoshop, each photo, graphic, text, or adjustment to a 
picture is placed on a separate layer. The use of layers allows you great control in 
creating composite photo images, or in selecting and removing key elements in a photo 
to use in other photos or applications. For example, you can select your grandkids and 
remove them from their backyard and place them high atop the Statue of Liberty! Or you 
can remove the Stop Sign which is protruding from Aunt Loretta’s head in the July 4th 
family photo. 
 
But more control means more complexity.  Adding text and shapes such as arrows is 
pretty simple in some photo programs.  In Photoshop you need to use Layers.  Putting 
each addition to a picture in a layer gives lots of control and the ability to precisely edit 
changes. Along with layers come adjustment layers, fill layers, layer masks and layer 



styles. This is where Photoshop gets complex, and separates the average user from the 
graphic artist. I need lots more practice with layers. Doesn’t everybody? 
 
Photoshop CS2 can now create layer groups using the Layers Palette. The Group 
becomes a folder that you can add layers to within the group, operate on them as you 
choose as you would any layer, editing, applying styles, the whole gamut, keeping them 
within the Group or bring them up to the master layer level. Also, I can now select 
multiple layers without linking. Hold down Shift to select all the contiguous layers or the 
Control key to select individual layers. To transform or move several layers, select them 
and transform them together without the need to link. It’s quicker and more convenient. 

Smart Objects are new to CS2, and offer more control over sizing and resizing pictures 
and graphics without any loss of image quality. A Smart Object groups objects together, 
for example, a layer containing a logo, and a layer containing some text, or even a 
camera raw photo. The source layers disappear, and a new Smart Object layer takes 
their place. Smart Objects work just like any other layer: You can move them, transform 
them, change their opacity and blending mode, and even apply Layer Styles. However, 
you can always open them in their original state and edit them. Smart Objects allow for 
non-destructive editing, since none of the changes you make affect your original data. 
You can duplicate the Smart Object layer many times in your overall image, and simply 
edit the original to make changes in all the copies, or change their size many times 
without losing any image quality. Smart! 

Blending Options have been improved in CS2. This feature brings up a screen called 
Layer Style which brings together many of the options for blending that you had to 
search for in Elements 4.0. It provides options for blending groups, layers and 
subgroups.  

The Photomerge routine, which stitches together overlapping photographs, surprised 
me by how easy it was to learn and use.  I had a series of pictures from a mountain top 
that I wanted to blend into a panorama.  I first searched Photoshop Help under “stitch” 
and found nothing; then under “panorama” I found easy to use directions.  The menu 
sequence File>Automate>Photomerge brings up a dialog box that allows the user to 
browse for the relevant photo files.  It did not matter that my photographs were in 
camera raw format.  Photomerge put the pictures on a virtual light table and took a 
guess at the order in which to merge them.  I had to drag and drop a few frames that 
could not be automatically sequenced.  Shooting without a tripod, I had slightly raised 
the camera as I took each frame.  My final panorama had a slight stair step across the 
bottom, but the overall result was good.  I noticed that the “Advanced” option takes a 
little longer, but does a better blend of the sky from frame to frame.  
 
Clipping Masks allow you to use the content of a layer to mask the layers above it. The 
transparent pixels of the bottom or base layer mask the content of layers above it that 
are part of a clipping mask. The content of the base layer clip reveals the content of the 
layers above it in the clipping mask. Need I say this is for advanced users. 
 



High Dynamic Range (HDR). The human eye sees a far wider spectrum of color that 
cameras cannot capture and monitors cannot display. HDR allows you to take 
bracketed pictures of varying exposures and merge them into 32-bit High Dynamic 
Range images.  This advanced technology adapts to the full spectrum and range of 
visible light as does the human eye, letting you display your final images with richly 
detailed shadows and highlights that no digital camera can capture (although some film 
cameras can, like a Hasselblad medium format). 
 
Part 4: Additional Features in CS2. Crop and Straighten Photos is the coolest feature 
for those of us who still scan photos from time to time.  Last week I found my self 
scanning dozens of photos for a teaching presentation I was doing.  In the past, I laid 
out several pictures on the scanner, and set the software’s frame to laboriously scan 
each photo separately. Time consuming. Now I lay out several photos on the glass, hit 
the button to scan the entire glass, repeated this 20 times, and then start Photoshop 
CS2. Using the Crop and Straighten Photos feature, Photoshop automatically crops and 
straightens each of the 4 to 6 photos in the scanned page, gives each photo a separate 
variation on the file name, and is ready to save them in just moments. A great time 
saver! 
 
Font Preview. You can now get a real sample of each font in the font menu. Its about 
time, Adobe! With preferences you can change the size of the preview or turn it off. The 
font preview works for me and is a big improvement over no-previews in CS, even 
though the sample word (Sample) is so simple.  I prefer programs that use the name of 
the font for the sample. Still, it is easy enough to change the font of the text until I get 
what I want. 
 
Vanishing Point is a very clever filter with tools which allows you to create 3-D planes on 
your images and then paste text or photos onto buildings or other elements, while giving 
the new text or photo the same 3-D perspective as the original building. It sounds 
complicated, and I found it somewhat difficult to use. Vanishing Point also allows 
painting, pasting, retouching or cloning all in 3-D perspective. It automatically matches 
the new elements to the perspective of the surrounding image area. A powerful tool that 
takes time to learn. More tools are needed within the Vanishing Point filter than the few 
that are provided. 
 
Image Warping allows you to warp images, similar to warping text. Just click and drag 
your image to pinch and bulge it. This is a non destructive filter so you can restore the 
image to its original shape at any time. Image Warping allows you to shape that label to 
fit a surface exactly.  
 
Web Photo Galleries allows you to easily display your photos online and elicit feedback 
from viewers. 
 
Help me! Photoshop now has an improved help area which contains tutorials on CS2 in 
addition to the usual detailed explanations of procedures and terms. You can bookmark 
your favorite topics to create a reference section of your favorite techniques. 



 
Customizable menus allow you to hide menu items you don’t use or highlight those you 
do use frequently. You can customize other menu items and your workspace to your 
liking. Menu items can be re-defined using keyboard shortcuts. You can show or hide 
menu items and add color to menu items. You can also change the size of the text in 
the options bar, palettes, and Layer Styles dialog. You can create a more streamlined 
interface by eliminating commands you never use. This simplified interface is especially 
helpful when you©re teaching, or if you use only a small part of Photoshop©s feature set. I 
often assign a keyboard shortcut that I can remember to my favorite menu commands. 
 
Print Preview. Adobe has fine-tuned CS2’s Print With Preview dialog box, to simplify 
some of the confusing color-management options. Print With Preview is definitely the 
way to print from Photoshop, with maximum control. 
 
Summary: Photographers using CS2 will be happy with the enhanced and much more 
powerful Bridge, Camera Raw, Smart Sharpen, Lens Correction, Red-Eye and Noise 
Reduction Features. Photoshop is the industry benchmark standard and a very powerful 
photo editing program.  I believe Photoshop will be with us for a very long time, so your 
investment in time and money will result in a lifetime of better pictures. There’s lots of 
free help and tutorials on the Web, and classes and seminars are widely available (see 
Resources below). I believe there are enough new features to justify the upgrade from 
CS, and it’s absolutely a great upgrade for users of 7.0 and earlier, or Photoshop 
Elements. 
 
The weak points are two: it’s expensive and complex. How expensive? Even with the 
$50 price drop from the previous version, street price is around $590. Try to get the 
upgrade price from an earlier version of Photoshop. Its $150 to upgrade to the standard 
version from any previous version. Or, if you’re a student or teacher, get the academic 
pricing from Academic Superstore or similar web site (see Resources below).  
 
Photoshop CS2 is a very complex program which can take years to learn in depth and it 
can be a steep learning curve for new users. Then again, what are you doing with the 
rest of your life? I’m learning Photoshop! 
 
Point/Counter Point: Our four reviewers had some personal comments on Photoshop 
CS2. Here are their unedited comments: 
Priebe: “It’s wonderful, it’s marvelous, that’s why I fell in love.” (Sung to ‘S Wonderful, by 
Diana Krall.) 
Carlson: “Priebe’s lost his marbles. 20 hours straight writing a review will do that to you.” 
Johnson: “Adobe-sha-mobe. CS2 is a great algorithm. Que sera sera.” 
Warren: “After nine months of using CS2, I can say that it has met my expectations both 
in capability and complexity.  It can do almost anything.  It is far more complex and 
more challenging than the much cheaper photo processing programs.  I’ll still be 
learning more about CS2 for a long time to come.” 
 
 



Glitches: 
Priebe: “CS2, like all prior versions of Photoshop, runs smoothly and remains stable. I 
don’t remember it ever crashing or locking up. A fast computer and dual-monitor video 
card is a big help. But why are half of the filters unavailable for 16 and 32 bit images?  
Let’s get with it, Adobe, and get all the features working with high-end images.” 
Carlson: “Bridge has a few inconveniences, but I can easily live with it for the great 
features. Chuck, what’s the deal with your wife?” 
Johnson: “My wife still prefers unsharpened photos. I don’t get it.” 
Warren: (In a Mr. Spock voice) “I have an annoying incompatibility on my computer 
between CS2 and my general utility program SystemSuite 6. The register cleaner of 
SystemSuite 6 destroys some identification file set up by CS2. I talked with Adobe about 
this. The only cure is to reinstall CS2, or burn my SystemSuite 6 at the stake. I’m still 
thinking about it.” 
 
Additional Info & Resources: 
Minimum Windows Computer System Requirements for CS2: Intel® Xeon™, Xeon 
Dual, Intel Centrino™, or Pentium® III or 4 processor. Microsoft® Windows® 2000 with 
Service Pack 4, or Windows XP with Service Pack 1 or 2; 320MB of RAM (384MB 
recommended); 650MB of available hard-disk space (Are you kidding? You’ll need a ton 
more), 1,024x768 monitor resolution with 16-bit video card, CD-ROM drive, Internet or 
phone connection required for product activation. 
 
Adobe Photoshop CS2 is manufactured by Adobe Systems Incorporated, 345 Park 
Avenue, San Jose, CA 95110. www.adobe.com  Tech support: complimentary 
resources available on the Adobe website; person-to-person support re: installation and 
product defects. Paid support plans available through Adobe Expert Support. 
 
Bank Account Requirements to Purchase CS2. I never said it wasn’t expensive. But the 
best never is, right?  There are some deals out there for students and upgraders. 

1. Amazon.com recently offered CS2 for $590 or an upgrade from any prior version 
of Photoshop for $150 at: http://www.amazon.com/s/ref=br_ss_hs/104-0748481-
7398325?platform=gurupa&url=index%3Dblended&keywords=photoshop+cs2  

2. Academic Superstore offers CS2 for students and faculty for $290 at: 
http://www.academicsuperstore.com/item/?tname=244935&title=Photoshop+CS2  

 
Photoshop Training: There are a zillion books on Photoshop, and just as many web 
sites with tips, training materials or tutorials. For books, see the link above for 
Amazon.com, or Adobe’s own site. Here are five online sites for training: 

1. Photoshop CS2 comes with 60 minutes of training tutorials on a CD from Total 
Training: http://www.totaltraining.com/prod/digitalphoto.asp?mscsid=   

a. Also, the CS2 Welcome Screen (available in the Help Menu) offers 6 
different levels of training, including on-line assistance.  

b. Photoshop Help (F1) offers it own set of tutorials which cover many topics 
you’ll want to know. In addition, other resource links are given for Adobe 
training & tutorials, including: 
http://studio.adobe.com/us/search/sort?sort=topic&product=15&topic=0&type=all&level=a
ll&x=8&y=6  



c. And Adobe’s Design Center tutorials: 
http://www.adobe.com/designcenter/tutorials/  

2. Excerpts from Classroom in a Book Tutorials: 
http://www.adobe.com/designcenter/tutorials/phscs2it_cibexcerpts/  

3. Receive a free email daily with a link to an easy to follow on-line lesson on 
Photoshop from Craig at Watch and Learn Photoshop: 
http://watchandlearnphotoshop.com/tipsignin.html  

4. The National Association of Photoshop Professionals offers both free and 
membership-only training on-line at: http://www.photoshopuser.com/how.htm  

5. Free training on digital photography and Photoshop CS2 from Hewlett Packard. 
The classes are on a rotating basis, so if you miss one, you can pick it up later at: 
http://www.hp.com/united-states/hho/classes/index.html?jumpid=re_R602_mktg/hpcom/split/oc  

6. Check it out; lots of Photoshop tips and tutorials by a variety of experts:   
http://www.photoshopsupport.com/  

7. Photoshop TV – a weekly net broadcast or podcast of all things Photoshop, including tips and 
tutorials: http://www.photoshopguys.com/  

8. Photoshop tutorials by Colin Smith: http://www.photoshopsupport.com/tutorials/colin/masking-
images.html  

9. Photoshop Killer Tips: http://www.photoshopkillertips.com/  
10. The Luminous Landscape, the web©s most comprehensive site devoted to the art of landscape, 

nature and documentary photography  This site is completely non-commercial. It currently has 
more than 3,000 pages containing articles, tutorials, product reviews and photographs: 
http://www.luminous-landscape.com/  

 


